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Microsoft Access  

Part-I 

ShortCourse Handout 

Copyright 2019 Faith Harper, Texas Tech University. ALL RIGHTS RESERVED. Members of Texas Tech 

University or Texas Tech Health Sciences Center may print and use this material for their personal use 

only. No part of this material may be reproduced in any form without written permission from Faith 

Harper, the author. 

 

Introduction 

Microsoft Access is a Relational database Management System (RDBMS), which stores and retrieves 

information according to Relationships you define. With Microsoft Access, you can create tables to store 

your information, queries to retrieve information from the tables, and forms and reports to make the 

information available to users in various ways. The database files you create in Access have an .accdb 

extension.   

 

Access desktop databases can help you store and track just about any kind of information, such as 

inventory, contacts, or business processes. This handout will walk through the paths you can take to 

create an Access desktop database, add data to it, and then learn about next steps towards customizing 

and using your new database. 

 

Course Objectives 

After completing this ShortCourse, you should be able to: 

• Create a New database; 

• Create tables; 

• Work on the two views of a table; 

• Discuss basic database terminology; 

• Discuss the basics of good database design; 

• Work with an existing table; 

• Work with an existing form; 

• Sort and filter a table, and 
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• Print database objects. 

 

What is an Access Database? 

A database is collection of records and files that are organized for a specific subject or purpose.  Without 

writing code or being an database expert you can: 

• Use templates to build databases quickly. 

• Easily find and report on data stored in Access. 

• Create rich data entry forms. 

• Import, transform, and export a variety of data sources. 

You can use access to create databases such as: 

• A telephone directory 

• A timetable 

• Address book 

 

Getting Help  

You can get help by pressing the F1 key, by clicking the question mark icon in the upper-right corner of 

the Access File menu, or by clicking the Help tab in the open database.    

 

Designing and Documenting Your Database 

Access Database consists of a collection of Tables, Queries, Forms, and Reports that you build to 

manage, analyze, and present your data. These identifiable units (components) are called Objects. These 

objects are dependent to other objects in the database.  That is a Query, Form, or Report draws 

information from Tables so changing data in any of these objects changes the data in all these objects 

and the database. 

 

Because the objects in a database are related to one another, building a database requires careful 

planning. 

• Designer’s best tools are a pencil and paper. It is important to plan what you are doing.  If you 

don’t plan, you will often have to start again. 
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• Document what you are doing. Spend some time and effort getting this right.  If your underlying 

data structure is wrong then everything you do subsequently, will be much harder or may not 

function at all. 

• Define the purpose. Consider questions you may want to answer in the future. 

• Determine the tables (one for each subject) and kind of records it describe 

• (people, projects, orders, etc.) 

• Determine the fields – smallest piece of information. 

• Identify unique field value (Primary key). 

• Determine the relationships between tables. 

• Test the design by entering sample data and run a simple query. 

 

Follow the steps below when designing your database. 

• Identify Tasks - make a list of all major tasks you want to accomplish. For example, “Enter 

Customer orders.” 

• Chart the Task Flow - group the major tasks by topic. For example, separate employee-related 

tasks and sales-related tasks. 

• Identify Data Elements (Fields) - required by each task and required in calculation to make 

changes to the data. 

• Organize the Data elements by subject, such as a group, place, thing, or action that you need to 

track (each subject requires several data elements called fields such as name, address, etc.) 

• Create one table per Subject. 

• Design a User Interface - such as forms, reports, etc. 

• Test, review, and Refine the Database.  

 

Terminology 

• Database is a structured collection of information pertaining to a specific topic. 

• Database Objects are database elements such as tables, queries, forms, and reports. 

• Database Relationships are logical linking between tables.  They are ties that are created 

between tables in the database so that Access can combine data from more than one table.  The 

linking between two tables is called Join. 
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• Field is a space allocated for information about an object. It is the smallest unit of information 

you can retrieve from a database. 

• Foreign key is the primary key in another table 

• Form is an object designed and used for data input or display, one record at a time. 

• Null is a missing value (commonly the result of human errors). 

• Primary key is a field that uniquely identifies a record 

• Record is a row of data in a table, which is a set of attributes as defined by schema. 

• Report is an object designed and used for formatting, calculating, summarizing, and printing 

selected data. 

• Table is an object you define and use to store data. 

• Query is a request to retrieve specific information from a database. 

 

Command Tabs 

The following are some of the tabs and the commands available on each tab of the Ribbon. The tabs and 

the commands available change depending on what you are doing.   

 

Command Tab Common Actions for That Tab 

Home • Select different views 
• Copy and paste from the clipboard 
• Set fonts, spacing, fill color, etc. 
• Refresh, save, delete, total records 
• Sort and filter records 
• Find records 

Create • Blank tables 
• New tables with table templates 
• Forms 
• Reports 

External Data • Import data 
• Export data 
• Collect data and send data via e-mail 

Database Tools • Create and view table relationships 
• Run the Database Documenter or Analyze performance 
• Manage Access Add-Ins (Database Tools group) 
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Navigation Pane 

When you open a database or create a new one, the names of your database 

objects appear in the Navigation Pane. The database objects include your tables, 

queries, forms, reports, macros, and modules. Use the “double less than” button 

, to Open/Close the Shutter Bar (Navigation Pane) or press the F11 key. You 

can also expand or contract the width of the Navigation pane by positioning your 

mouse pointer over the right edge of the Navigation pane and then clicking and 

dragging the edge in either direction to the width you want. 

 

Use the double headed up/down arrows to expand/collapse the objects group. 

Right-click the blank space at the bottom of the Navigation Pane to perform a 

variety of tasks.   

 

Finding Objects in a Database 

• If the Search Bar does not automatically show in the Navigation pane, Right-click the menu bar 

at the top of the Navigation Pane and then click Search Bar. 

• While you type text in the Search… box, Access searches within the selected category for any 

groups that contain an object or object shortcut that meets your search terms. Any groups that 

don't contain a match are hidden. 

• Type either a part or the complete name of the object or shortcut in the Search Bar box. While 

you type characters, Access searches and eliminates any group headings that don't contain a 

match. 

• To perform another search, press BACKSPACE to delete characters, and then type the new text 

for which you want to search. 

Note: When you clear the Search Bar box, the Navigation Pane again displays all the available objects. 

 

To Use Database Templates  

• Once you open Access, select a database from the suggested templates on the Home page, such 

as Students, Asset Tracking, Contacts, etc. 

• If the Home page does not provide the template you are needing, select More Templates to 

view all Access templates. 
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• Give the database a name (and change the file location if you wish) and then click the Create 

button. 

• After your database is created, Access will open a Welcome menu to walk you through using 

that template. Click Get Started to remove this window.  

• Use the Navigation Pane to see what’s in your new database. 

• You can then edit the tables and other objects as needed. 

 

Creating a New Database 

• From the File menu, click New, and then click the Blank database button. 

• Click the folder icon  to change the file where the database is saved. 

• In the File Name box, type, My Friends, and then click Create.  

• Access creates the database with an empty table named Table1, and then opens Table1 in 

Datasheet view. The cursor is placed in the first empty cell in the Click to Add column. 

 

Creating a Data Table 

• Make sure your Fields tab (within Table 

Tools) is active, then click the View button 

and choose the Design View.  

• The Save As dialog box appears. 

• Type, Friends, in the Table Name: box and 

then click OK. 

 

Creating Table Fields 

• In Design View, click in the blank boxes beneath Field Name (immediately below ID—the Primary 

Key).  
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• Type the following fields names (columns names), pressing the Enter key (or tab key): 

o First Name  

o Last Name 

o City  

o State  

o Zip 

o Phone Number 

 

Creating Records (Populating the Table) 

• Click the View button, and then select Datasheet View. 

• When the alert window appears, click the Yes button to save the table. 

• Type the following data, pressing the Enter or Tab key once reaching the last field. 

Notice how the cursor moves down to the (new) record after one row is populated and the Enter or Tab 

key is pressed.  When you move on to a new record, Access automatically saves the previous record. 

 

Basic Table Design Rules 

• Make each record unique – that is, DO NOT repeat the same kind of information in the same 

table. 

• Make each field unique. 

• Make each field functionally dependent - that is, all the information in a record should be 

related.  If the field is not related to the subject, it should be in another table.  Each field in the 

table should describe the table’s subject. 

• Make sure that data is broken down into its smallest logical parts (First name & Last name). 

 

Naming Rules 

• Don’t give a table and a query the same name. 

• Capitalize the first letter of every word, and then combine them to make a field name. For 

example: UnitsInStock. 
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• Avoid spaces. Spaces are allowed in Access field names, but they can cause problems.  Consider 

using underscores instead. 

• Don't use the field name; Name.  Name is an Access keyword. Instead, use ProductName, or 

CategoryName. 

• Break Down Your Information - You want to have each field store a single piece of information. 

• Avoid Duplicating Information. 

• Avoid Redundant Information – for Age and a DateOfBirth field, you'll want to include just a 

DateOfBirth field.  Or for a DiscountPrice field (in a Products table), you should be able to 

calculate the discount price as needed based on a percentage. 

• Include an ID Field.  It's a good idea to get into the habit of using ID fields in all your tables.  In 

some cases, your table may include a unique field that you can use as a primary key. 

Notice: You cannot use the following characters in an Object name: 

o Accent grave ` 

o Exclamation point ! 

o Period . 

o Brackets [] 

o Question mark ? 

o At sign @ 

o Slash / 

o Back slash \ 

o Less than sign < 

o Greater than sign > 

o Asterisks * 

o Pipe| 

o Colon : 

o Leading space 

o Non-printable characters 

 

Using the “Save As” Dialogue Box to Save a Copy of a Table 

• While your database is open, expand the Navigation pane. 

• Choose the “Tables and Related Views” from the Navigation pane to see All Tables. 

• Open the Order Details: table (Double-click the table). 
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• Click the File button, and choose Save As. 

• Click Save Object As (to save the current table as a new table). 

• Click Save As. It will then prompt you to name your object. 

• Click Publish. 

You can Save As the following objects: 

o Tables 

o Queries 

o Forms 

o Reports 

Note: to delete a table, using the Navigation pane, you must close the table first (if it is open).  

 

The Primary Key 

A primary key is a field or set of fields with values that are unique throughout a table. Values of the key 

can be used to refer to entire records because each record has a different value for the key. Each table 

can only have one primary key. Access can automatically create a primary key when you create a table, 

or you can what field you want to use as the primary key. 

 

If your database doesn't have an ID field (perhaps because you created it using the Create Tables Table 

Design command), it's up to you to create one and set the primary key. Here's how to do it: 

• In Design View, create a new field by typing a name in the Field Name column. 

• In the Data Type column, choose AutoNumber.  By choosing the AutoNumber data type, Access 

generates a unique ID value for every new record you insert. Or, you can choose the Text or Number 

data type. Then, you'll be entering your own unique value for each record. 

• In Design View, right-click the field, and then choose Primary Key.  Note: To make a primary key 

that includes more than one field, click the margin next to the field name, and then drag the mouse 

to select more than one field. Then, hold down the CTRL key and then right-click your selection. 

Now you can choose Primary Key. 
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What Kind of Primary Key Should You Use? 

• AutoNumber Primary Keys - Can be set to automatically enter a sequential number as each record 

added.  This is the simplest way to create the primary key. 

• Single-field Primary Keys - Unique values such as ID Numbers or Part Numbers are set as the 

Primary key. 

• Multiple-field Primary Keys - In many-to-many relationship you need to create a (Junction) table. 

Then, the Primary Keys from the two one-to-many tables together will be the primary key for this 

Junction table.  Hold down the Ctrl key and using the field selector, select both fields to set the 

multiple primary key. 

 

Data Types for Access Databases 

When creating tables, you need to select a data type for each 

column of data. The Short Text data type is the default data type 

since it lets you enter almost any character (letter, symbol, or 

number). However, careful selection of data types can help you 

with data validation and functions and improves the accuracy of 

the information you are storing. 

 

When to Use Which Data Type 

Data type is a set of qualities that applies to all the values that are contained in the field. For example, 

values that are stored in a Text field can contain only letters, numbers, and a limited set of punctuation 

characters, and a Text field can only contain a maximum of 255 characters.  

 

Sometimes, the data in a field may appear to be one data type but is another. For example, a field may 

seem to contain numeric values but may actually contain text values, such as room numbers. While in 

Datasheet View for the Friends table, select the right-hand arrow in the cells under Data Type to 

change your type of data for that field. 
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Overview of Basic Data Types Available in Access 

Data Type Usage Size 

Short Text (formerly 

known as “Text”) 

Alphanumeric data (names, titles, etc.) 

 

Up to 255 characters. 

 

Long Text (formerly 

known as “Memo” 

 

Large amounts of alphanumeric data: sentences and paragraphs.  

 

Up to about 1 gigabyte (GB), but controls to display a 

long text are limited to the first 64,000 characters. 

 

Number Numeric data. 

 

1, 2, 4, 8, or 16 bytes. 

 

Large Number 

 

Numeric data. 

 

8 bytes. 

Date/Time 

 

Dates and times. 

 

8 bytes. 

 

Currency Monetary data stored with 4 decimal places of precision. 

 

8 bytes. 

 

AutoNumber Unique value generated by Access for each new record. 

 

4 bytes (16 bytes for Replication ID). 

 

Yes/No 

 

Boolean (true/false) data; Access stores the numeric value zero (0) for false, 

and -1 for true. 

 

1 byte. 

 

OLE Object 

 

Pictures, graphs, or other ActiveX objects from another Windows-based 

application. 

 

Up to about 2 GB. 

 

Hyperlink A link address to a document or file on the Internet, on an intranet, on a 

local area network (LAN), or on your local computer 

 

Up to 8,192 (each part of a Hyperlink data type can 

contain up to 2048 characters). 

 

Attachment You can attach files such as pictures, documents, spreadsheets, or charts; 

each Attachment field can contain an unlimited number of attachments per 

record, up to the storage limit of the size of a database file. Note, the 

Attachment data type isn't available in MDB file formats. 

 

Up to about 2 GB. 

 

Calculated You can create an expression that uses data from one or more fields. You 

can designate different result data types from the expression. Note, the 

Calculated data type isn't available in MDB file formats. 

 

Dependent on the data type of the Result Type 

property. Short Text data type result can have up to 

243 characters. Long Text, Number, Yes/No, and 

Date/Time should match their respective data types. 

 

Lookup Wizard 

 

The Lookup Wizard entry in the Data Type column in Design view is not 

actually a data type. When you choose this entry, a wizard starts to help you 

define either a simple or complex lookup field. A simple lookup field uses the 

contents of another table or a value list to validate the contents of a single 

value per row. A complex lookup field allows you to store multiple values of 

the same data type in each row. 

Dependent on the data type of the lookup field. 
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Managing Field Sizes 

You can change the field size by using the Field 

Properties menu within Design View. Assign the field 

size you need in the cell next to the Field Size property. 

 

Recommended Maximum Field Sizes 

• First names and last names - 25 characters should be adequate for a first name, while 50 

characters should account for long, hyphenated last names. 

• Middle initial - One character. 

• Email address- 50 characters. 

• Cities, states, and countries - 50 is enough for most practical purposes. 

• Street address - A street address consists of a number, followed by a space, then the street 

name, another space, and the street abbreviation (like Rd or St). 50 characters should be long 

enough, if you put postal codes, cities, and other postal details in separate fields. 

• If you want to store the phone number like (888) 123-4567, make the field 11 characters long 

(ignoring the place holders). You can then store the phone number as 8881234567, but use an 

input mask, to add the parentheses, spaces, and dash when you display it. 

 

Database Relationships 

After you have set up different tables (one for each subject) in your Access database, you have to give 

Access a way to bring that information back together again. You do this by placing common fields in 

tables that are related, and by defining relationships between your tables. 

• Relationships work by matching data in the Key fields (Primary and Foreign keys). 

• Relationships are logical linking between database tables. 

Note: you need to make sure that the related key fields have the same name, data type, and size in both 

tables. 

• Table relationships are the foundation upon which you can enforce integrity to help prevent 

orphan records in your database.  An orphan record is a record with a reference to another 

record that does not exist.  For example, an order record that references a customer record that 

does not exist. 
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Types of Relationships 

• In a One-to-One relationship, each record in table A has only one matching record in table B.  

One-to-One relationships are uncommon! 

• In One-to-Many relationship, each record in table A has many matching records in table B.  This 

is the most common type of relationships. 

• In Many-to-Many relationship, a record in table A has many matches in table B, and a record in 

table B has many matches in table A.  This type of relationship is possible by defining a third 

table (called a junction table) whose primary key consists of two fields (the primary key s of both 

tables A & B) – (press the shift key & select both & press the key). 

 

 

 

 

 

 

 

 

 

 

Creating Relationships and Enforcing Referential Integrity 

Creating relationships allow you to pull together related data from different tables.  They are also 

useful when you are creating forms, queries, and reports. To create a relationship, you should have at 

least one field that is common in both tables.  

• Within the Database Tools, choose Relationships from the Relationships Group. All active 

relationships should be shown here.  

• To create a relationship, click-and-drag the same fields in one table and drop it on the same 

field in another table (the primary key, and the foreign key). 

• When the Edit Relationships dialogue box appears, select the Enforce Referential Integrity.  

Referential integrity is a system of rules that Microsoft Access uses to make sure that 

relationship between records in related tables are valid and that you don’t accidentally delete or 

change related data. If you change the field in one table, the field will be updated in all other 

tables in which relationships exists. That is related fields should have: 
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o Same Name 

o Same Data Type 

o Same Field Size 

• Close the Relationships window (for a new relationship, you would click Create). 

• When you Relationship tab is open, use the Relationships group within the Relationship Tools 

to add and edit relationships. 

 

To Print the Relationships Report 

• Choose the Relationships command in Relationships group on the Database Tools tab. 

• Rearrange the Tables (your Relationship Report will print exactly as it appears on the screen). 

• Choose the Relationship Report command in the Tools group on the Relationships Tools Design 

tab. 

• Modify your page layout setting as necessary. 

• Choose the Print command in the Print group on the Print Preview tab. 

 

Practice Exporting Objects using the Northwind Traders Sample Database 

• In the Navigation Pane, click the arrow on the Tables tab, and select All Access Objects.  

• Expand the Reports object and select the Customer Address Book report. 

• On the External Data tab, in the Export group, select the More drop-down button, and then 

choose the Word command. 

• Browse and find a folder to save your file. 

• Click OK (you can choose whether to save export steps). 

• Close the Export-RTF file window. 

• Close the Customer Address Book report (Right-click the tab > Close). 

• On the Navigation pane, click the Tables object. 
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• Find and double-click the Products table, to open it. 

• Click the Excel command on the External Data tab, on the Export group. 

• Browse and find a folder in your computer to save this file. 

• Check mark the “Export data with formatting and layout” box. 

• Check mark the “Open the destination file after the export operation is complete” box. 

• Click OK. 

• Close the Excel file, and Excel program. 

 

Using the Date Picker 

When you place the cursor on a Date/Time field, the Date Picker (calendar icon) appears at either the 

right or left sides of the field, depending on your computer language settings. 

When you click the Date Picker, a calendar control appears. 

 

You can use the calendar to select a date or click Today to enter today's date. Note: If you use an input 

mask for a Date/Time field, the Date Picker control is unavailable for use with that field. 

 

Add a Date Field to the Friends Table 

• Open the table in Datasheet view, and then click the down arrow next 

to Click to Add and select Date & Time from the drop-down field list. 

Repeat to add a second new field.  

• Double-click the field headings and rename the new columns to Arrival 

Date and Flying Time, respectively. Switch to Design view. 

• In the upper section of the design grid, select the Date/Time field (in 

the Data Type column) that you want to format. 

• In the Field Properties section (bottom portion of the page), click within 

the Format property box, then select the drop-down arrow in the far 

right of the same box. Choose a format from the drop-down list. Repeat 

these steps for the second Date/Time field. 

• Switch to Datasheet view, click YES to save the table. 
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Adding Quick Start Fields 

Quick Start fields in Access enable you to add fields you use regularly to your data tables with a simple 

click of the mouse. Instead of adding Address, City, State, ZIP, and Country codes one by one, for 

example, you can click the Address Quick Start field to add all the fields in 

one click. 

• Access includes nine Quick Start fields by default: Address, Category, 

Name, Payment Type, Phone, Priority, Start and End Dates, Status, 

and Tag. 

• To add a Quick Start field to your data table, open the data table 

you want to use and click to select the field to the right of the place 

you want to add the field.  

• In the Table Tools Fields tab, click More Fields in the Add & Delete 

group. 

• Scroll down to the bottom of the list to find the Quick Start fields 

and click the one you want to add to the data table. 

• Each Quick Start field you add has preset field options already 

included. For example, when you add the Payment Type Quick Start 

field, the added field includes Cash, Credit Card, Check, In Kind, and 
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Debit selections as part of the field. You can customize the field to include the selections you 

want by right-clicking the field and choosing Edit List Items. You can modify, remove, or add 

values to the list by clicking and typing the new entry. Click OK to save your changes. 

 

Adding a Quick Start Field to the Friends Table 

• Select the Click to Add heading to highlight the column. 

• Under Tables Tools, Fields, Add & Delete area, select the More Fields drop-down. Scroll until 

you reach the Quick Start Field options and select Status. A new Status field should be added to 

the left of the Click to Add column in your table. 

• When you click the drop-down arrow in the first cell under Status, you will have the following 

default options: Not Started, In Progress, Completed, Deferred, Waiting.  

• Change these options by right clicking in the Status column, selecting 

Modify Lookups, inputting your new options (i.e. Boarding, Departed, 

In-Flight, Landed, Delayed, Cancelled), then completing the Lookup 

Wizard steps until the process is finished.  

 

Moving Fields (Columns) 

• On Datasheet View, click the column heading Phone Number to select the column. 

• Place the curser on the selected column heading. 

• Click and drag the column until a thick black line appears between the columns Last Name and 

City. 

• On the Title Bar, click the Save icon. 

• Close this table 

 

Change the Default File Format 

• From the File menu, click Options. 

• In the Access Options dialog box, click General. 



Microsoft Access ShortCourse Handout  Updated 2/13/2020 by Faith Harper 

22 
 

• Under Creating databases, in the Default file format for Blank Database box, select the file 

format you want as the default. 

• Click OK. 

Note: You cannot convert a database that uses an earlier format to a web database. 

 

Creating Forms 

• In the Navigation Pane, double-click the Friends table to select. 

• Click the Create tab. 

• Click the Form button, in the Forms group. 

• A created form opens in Layout view.  

• Once your form is created, you can then click between Form 

View, Layout View, or Design View in the upper left-hand corner of the Form Layout Tools, 

Design tab. 

 

Adding a New Record to the Table Using the Form 

• Click the View button to switch to Form View of the form. 

• Use the Form View to add another record to the Friends Table. 

• In the Records group of the form window, click the button.  

TIP: If you see a Security Warning bar above the form, click the Options…button, click the Enable this 

content radio button, and then click OK. 

• Click inside the boxes in the form and type the data, pressing the TAB key to move from one box 

to another. When finished, the form should progress to a new, blank record. The old record has 

been saved. 

• To navigate between the completed records, use the record locator at the bottom of the page. 

The arrows will take you to the next or previous record as needed. 
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Creating a Query using the Query Wizard 

A query is a question you ask from a database. It’s is a way of getting specific information from a 

database. You use queries to ask the database questions like, "Who are my friends in Texas?" 

• Open the Northwind Sample Access database. 

• Double click the Invoices table to make it active. 

• On the Create tab click the Query Wizard in the Queries group.  

• Select the Simple Query Wizard and then click OK. 

• Double-click any field in the Available Fields: list to select the fields. 

• Or click the button to add one field to the Selected Fields: list. 

• Click Next. 

• When the final screen appears, type a name for your query. 

• Click Finish. The query is automatically saved and executed. 

 

Query Criteria 

A query criterion is like a formula and may consist of field references and operators (operator: a sign or 

symbol that specifies the type of calculation to perform within an expression). Query criteria are also 

called expressions.  

 

When you want to limit the results of a query based on the values in a field, you use query criteria. A 

query criterion is an expression that Access compares to query field values to determine whether to 

include the record that contains each value.   

 

Using a Comparison Operator to Specify Criteria 

• Display the query in Design View (right-click 

the query tab/heading Design View). 

• Click the Criteria box for the Order ID field. 

• Click the Builder button in the Query Setup 

group. 

• Click the appropriate comparison operator 

button, and specify the criteria (> 70, for 

example). 
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• To see additional comparison operator, expand the Operators element, and choose the 

Comparison Operator you want to use. 

• Enter a value or click a field whose value you want to compare. 

• Click OK. 

• Be sure the Show check box is checked for each field that you want to 

show alongside your criterion field. 

• Click the Run button 

 

Examples of query Criteria for Numbers and Currency Fields 
To include items that . . . Use this criterion: Query results returns items (records) 

where the unit price . . .  
Exactly match a value, such as 100 100 Of the product is $100 
Do not match a value, such as 1000 Not 1000 Of the product is not $1000 
Contain a value smaller than a 
value, such as 99.99 

<100 
<=100 

Is less than $100 (>99.99). The second 
expression displays items in which the unit 
price is greater than or equal to $100 

Contain a value larger than a value, 
such as 99.99 

>99.99 
>=99.99 

Greater than $99.99. The second expression 
displays items where the unit price is greater 
than or equal to $99.99. 

Contain one of the two values, such 
as 20 or 25 

20 or 25 Is either $20 or $25 

Contain a value that falls within a 
range of values 

>49.99 and <99.99 
-or- 
Between 50 and 100 

Is between (but not including) $49.99 and 
$99.99 

Contain a value that falls outside a 
range 

<50 or >100 Is not between $50 and $100 

Contain one of many specific values In(20,25,30) Is $20, $25, or $30 
Contain a value that ends with the 
specified digits 

Like “*4.99” Ends with “4.99,” such as $4.99, $14.99, $24.99 

 

Comparison Operators Used in Query Criteria or in Expressions 
Operator Meaning Example 

= Equal to / Same as = 5 
< Less than / lower than < 5 
>NOW() After the current date  
>DATE() Today or after  
<= Less than or equal to <= #6/1/2016# 
>= Greater than or equal to >= #6/112016# 
<> Not equal to <>5 
And And >=50 and <= 100 
Or Or TTU or Duke 
Like Test a text to match a pattern string Like “Jon*” 
Not Logical not  Not >5 
In Test for any member in a list In(“CA”, “OR”, “WA”) 
Between Test for a range of values Between 1 and 5  
Is Used with Null to determine whether a value is Null or Not Null Is Not Null 
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Using Wildcards in Queries 

Note: with operators such as “Like,” wildcard symbols are used to allow making complex searches for 

information easier. You can use the following wildcards: 

* Wildcard is used for any group of characters in this position. 

 Example: B*ge finds Baggage, Barge, etc. 

? Wildcard is used for any single character in this position. 

 Example: J?ne will find June and Jane 

# Wildcard is used for any single digit in this position. 

 Example: 199# will find all years between 1990-1999 

 

Creating Reports with the Report Wizard 

• Select the Create tab, and then click the Report Wizard in 

the Reports group. 

• Click the Tables/Queries drop-down arrow, and then select 

a table or a query. 

• Click the  button to move all the fields into the Selected Fields list. 

• Click Next (three times). 

• When the layout screen appears, select either Stepped, Block, or Outline. 

• When the final screen appears, type a name for your report. Then click the Preview the report 

radio button. 

• Click Finish. The report is automatically created, saved and opened. 

 

When is Data Saved? 

When you edit data in a table or a form, your changes are automatically saved when you navigate to 

another record or when you close the table or the form. 

 

To Back Up a Database 

• Click the File menu, and then click Save As. 

• Click Save Database As, choose the format you want to save in, and then click Save As. 
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Input Mask 

An Input Mask is used to pre-format a field to “Display/Store/Act” a certain way when a user inputs 

data.  For example, you could create an input mask for a Social Security Number field that automatically 

inserts the dashes.  Input Mask specifies the way a user should enter data into the field.  It is a defined 

format for the field. You can either quickly add input masks by using the Input Mask Wizard or specify 

masks manually by typing custom masks to the Input Mask field property setting.  While the Input Mask 

Wizard provides input masks for most common formatting needs, you may sometimes want to 

customize input masks to better suit your needs.  

Note: Input Mask Wizard only works with Text or Date field types.   

 

To Add an Input Mask to a Table Field Using Predefined Masks 

• Reopen the My Friends Access database. 

• In the Navigation Pane, Right-click the Friends table, and then click Design View. 

• Click in the Phone Number row. 

• In the Field Properties area of the window, click in the Input 

Mask property. 

• Click the Build button beside the Input Mask property 

• In the Input Mask list, select the  button to choose the 

mask that you want to add.  

• Click Try it and enter data to test how the mask displays. 

• To keep the input mask without any changes, click Next. 

• Select an option for how you want the data to be stored. 

• Click Finish and save your changes. 

• On the Home tab, click View, then Datasheet View. 

 

Validation Rules 

A Validation rule is field specific rule that imposes a constraint that defines a set of values for a given 

field. 

• You use Validation Rules to restrict your data to the way it will be accepted in one or several 

fields. 

• You can type Validation Rules in or use the Validation Rules Wizard. 
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• Validation rules work hand in hand with Input Masks to prevent bad data entry. 

• You create Input Mask or Validation Rules on the Design View of a table, in the General tab of 

the Field Properties. 

Note: Don’t specify a Validation Rule without Validation Text, since Access may generate an “Ugly” 

message that your users might not understand.    

Here are some Examples: 

Field Type Validation Rule Definition 

Number > 0 Must be greater than zero 

Date >=Date() or Is Null Today’s date, later, or blank 

  

Validating Data During Entry in Table Fields 

To apply field validation during data entry, select the field, and then navigate to the Fields tab, from 

Validation drop down list, click Field Validation Rule.  You will reach Expression Builder dialog; here you 

can write an expression to validate the field entries.   

 

 

 

 

 

 

 

 

 

  

Recommended Online Resource 

• Free online video training library at www.cbt.ttu.edu. 

• TTU Safari e-Books at http://library.ttu.edu .  More than 6000 Safari eBooks to access 

for four simultaneous users.  Please use the log-out link when you are done using the 

database. 

Please E-Mail your questions, comments, or suggestions to ITEducation@ttu.edu. 

http://www.cbt.ttu.edu/
mailto:ITEducation@ttu.edu
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Class Exercises 

Exercise 1 

1. From the File menu, click New.  By default, Blank Database is highlighted.  In the File 

Name box, type Sue's Wedding, and then click Create.  Access by default, creates a new 

table in Datasheet View called Table1 with an ID field already defined. 

2. Click the View button, the Save As dialog box Opens. 

3. Type Guests List for the table name, and then click OK.  Guest List Table Opens in Design 

View. 

4. Using the following table, type the table field names (see below image), choosing data 

type, description of each field, and pressing the Enter key each time 

5. Make the ID field the primary key for this table (Right-click the field, and then choose 

Primary Key), if it is not already selected as the Primary key for this table. 

6. When finished, close and Save this table. 

7. Click the Datasheet View button on the Ribbon (View > Datasheet), to switch to 

Datasheet view. 

8. Enter the data into the table (populate the table).  Note: don’t start typing in the middle 

of the table, since this is not an Excel spreadsheet. 

9. When finished, close this table. 

 

Exercise 2 

1. Click the Create tab on the Ribbon. 

2. Click the Table button in the Tables Group. 

3. On the View dropdown button, choose Design View, type: City for the table name, and 

then click OK to save the table as City.  This table opens in Design View. 
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4. Using the following given table, enter the table’s field names.  Note: either keep the 

Flying Time field’s data type “Short Text,” or if you are choosing “Number” for this field’s 

data type, then you need to format it as Decimal in the Field Properties section.  Select 

Format: Standard, and Decimal Places: 1. 

5. Make the City field the primary key for this table (Right-click the field, and then choose 

Primary Key), if it is not. 

6. Click the Datasheet View button on the Ribbon, to switch to Datasheet view. Click Yes 

to save the table when prompted. 

7. Enter the data (populate the table). 

8. To format your table, on the Home tab, in the Font group, click the Alternate Fill/Back 

Color button, and then choose a color. 

 

 

 

 

 

9. When finished, close the table. 

 

City State Zip Distance Airline Flying Time 

Albuquerque  NM 88011 1540 XYZ 4.5 

Atlanta GA 30311 3500 XYZ 5.1 

Austin TX 78711 1880 XYZ 4.5 

Dallas TX 75200 1670 XYZ 4.3 

Denver CO 80100 1141 XYZ 2.4 

Fort Worth TX 75100 1670 XYZ 4.3 

Los Angeles CA 90035 678 XYZ 3.4 

Nashua NH 90030 2975 XYZ 6.2 

New York NY 01002 2840 XYZ 5.2 

Phoenix AZ 85000 1235 XYZ 3 
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Exercise 3 

1. Click the Database Tools tab on the Ribbon. 

2. On the Relationships group, click the Relationships button. 

3. On the Show Table dialog box, click ctrl + each table, and then click the Add button. If 

you don’t see your tables, click the Show Table button.  When finished, click Close. 

4. On the Relationships window, click+ hold + drag the common field, City (the primary 

key) from the City table to the common field in the other table (Guests List), and then 

release the mouse. 

5. On the Relationships dialog box, check mark the Enforce Referential Integrity box, and 

then click Create. 

6. Click the Relationships Report command, in the Tools group (on the Design tab) to see 

the Print Preview of your Report. 

7. Click the Close Print Preview button. 

8. Close any open windows. 

9. Close the Program (Exit). 

 

 

 

 

 

 

 

 


